
© 2020 Ex Libris | Confidential & Proprietary

2021年第一季度
Alma新功能在线研讨会

艾利贝斯中国技术支持团队



© 2020 Ex Libris | Confidential & Proprietary 2

议题和资料

• 议题

1. ExLibris Secure FTP Service – 介绍Alma提供的免费SFTP服务

2. All About Letters Configuration – 分享整理的信件定制文档
• 用户实例经验分享 - 南科大 – 邱老师

3. Analytics Use Case – 分享来自两个客户案例的分析报告案例

4. All About OAS and DV - 分享整理的分析与数据可视化文档

• 资料

• 相关演示文档会以PDF格式分享到Alma中国用户QQ群文档

• Alma中国用户交流QQ群：49483514
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重要提示和更新

• New Alma Layout Turned On for All Users (2020.11)

• PQ EBC Upload Electronic Holdings Improved (2020.11)

• SAML Certificate Workflow Update (2021.02)

• New MDE Layout Turned On as Default for All Users (2021.03)

• Support Discontinued for Internet Explorer (2021.03)

• New Alma Layout - Exclusive Use (2021.03)

• Go VE Rollout (2020.11)

• Partial Linking Indication in MDE (2020.11)

• New Ex Libris Secure FTP Service (2020.12)
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Go VE Rollout (2020.11)

• Go VE, the self-switch process to move from Primo to Primo VE, 
is being gradually rolled out and made available as part of the 
November release to all single institutions (which are not part of 
a Network Zone) who use the Primo Back Office together with 
Alma. The Go VE button is visible in the Alma menu to General 
System Administrator users.

• http://exl-edu.com/02_Primo/GoVE/GoVE_Web/story_html5.html

• https://knowledge.exlibrisgroup.com/Primo/Product_Documentation/Go_VE
/Getting_Started_with_Go_VE

http://exl-edu.com/02_Primo/GoVE/GoVE_Web/story_html5.html
https://knowledge.exlibrisgroup.com/Primo/Product_Documentation/Go_VE/Getting_Started_with_Go_VE
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XSLT as Part of an Integration Profile (2020.11)

• XSLT converters were introduced to Alma that enable converting 
data from source system formats to the format required by 
Alma, when importing users to Alma from SIS systems that use 
other data formats. Now this ability has been enabled to all 
customers.

• https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/010Alm
a_Online_Help_(English)/090Integrations_with_External_Systems/030Resour
ce_Management/440Integration_XSL_Converters?mt-draft=true

https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/010Alma_Online_Help_(English)/090Integrations_with_External_Systems/030Resource_Management/440Integration_XSL_Converters?mt-draft=true
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Partial Linking Indication in MDE (2020.11)

• The presentation of a link between a bibliographic heading with 
subdivision to an authority record without subdivision (partial 
linking) in the Metadata Editor was improved to better display 
the type of different types of linking. Now it more clearly 
displays partial and full linking.

• https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/010Alm
a_Online_Help_(English)/Metadata_Management/060Working_with_Authori
ty_Records?mt-
draft=true#Viewing_Linked_Names.2FSubject_Headings_from_a_Bibliograph
ic_Record

https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/010Alma_Online_Help_(English)/Metadata_Management/060Working_with_Authority_Records?mt-draft=true#Viewing_Linked_Names.2FSubject_Headings_from_a_Bibliographic_Record
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New Ex Libris Secure FTP Service (2020.12)

• Ex Libris now provides out-of-the-box Secure FTP service for file 
transfer between Alma and external system. The Ex Libris Secure 
FTP services provides a separate directory for each customer. 

• Limitations to the Ex Libris FTP server directories:

• Max 1GB for each directory (production/sandbox)

• Data retention period - 30 days

• https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/010Alm
a_Online_Help_(English)/050Administration/050Configuring_General_Alma_
Functions/050External_Systems/055Configuring_ExL_Secure_FTP_Service

https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/010Alma_Online_Help_(English)/050Administration/050Configuring_General_Alma_Functions/050External_Systems/055Configuring_ExL_Secure_FTP_Service
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All about the New MDE

• With the April 2021 release, the New Metadata Editor … 
providing full functionality … became the default editor… 
becomes the only editor by June 2021 release.

• New Metadata Editor Functionality - Ex Libris Knowledge Center 
(exlibrisgroup.com)

• Metadata Editor - Ex Libris Knowledge Center (exlibrisgroup.com)

• Presentations and Documents - Resource Management - Ex Libris Knowledge 
Center (exlibrisgroup.com)

https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/010Alma_Online_Help_(English)/010Getting_Started/050Alma_User_Interface_%E2%80%93_General_Information/046New_MDE_Functionality
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/010Alma_Online_Help_(English)/Metadata_Management/010MD_Editor
https://knowledge.exlibrisgroup.com/Alma/Training/Extended_Training/Presentations_and_Documents_-_Resource_Management#The_New_Metadata_Editor
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All about the OAS and DV

• 新的Analytics和数据可视化功能已经启用了一段时间，希望
大家可以在日常工作中更多了解和使用到相关功能。

• 这里提供参考和培训资料如下：

• Oracle Analytics Server (OAS) and Data Visualization (DV) - Ex Libris 
Knowledge Center (exlibrisgroup.com)

• OAS (Oracle Analytics Server) and DV (Data Visualization) - Ex Libris 
Knowledge Center (exlibrisgroup.com)

• Analytics - Ex Libris Knowledge Center (exlibrisgroup.com)

https://knowledge.exlibrisgroup.com/Alma/Best_Practices_and_How-Tos/Oracle_Analytics_Server_(OAS)_and_Data_Visualization_(DV)
https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/010Alma_Online_Help_(English)/080Analytics/010Introduction/The_Basics_of_Working_with_Analytics/OAS_(Oracle_Analytics_Server)_and_Data_Visualization_(DV)
https://knowledge.exlibrisgroup.com/Alma/Best_Practices_and_How-Tos/Analytics
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建议

• 定期查看 Alma 的版本更新通知 Release Note：

• Release Notes - Ex Libris Knowledge Center (exlibrisgroup.com)

• 留意更新信息包括如下部分：

• Make the Most of March's Release

• Upcoming Issues to Note

• Main Features

• Additional Enhancements

• Resolved Issues

https://knowledge.exlibrisgroup.com/Alma/Release_Notes
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建议

• 使用如下业务或组件关键字检索：

• Module: Acquisition / Fulfillment / Resource Management / Analytics …

• Terms: Metadata Editor / PO Line / CDI / GuideMe / Letters / Calendar …

• General Keyword: Hot Key / API / Integration …

• 请测试新功能并反馈，我们会为您提供技术支持

• 感谢您的参与，请填写问卷：

https://www.wjx.top/vj/P70pUGF.aspx

https://www.wjx.top/vj/P70pUGF.aspx
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ChinaSupport@exlibrisgroup.com

Thank you!
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Ex Libris Secure FTP Service
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重要提示

• 从2020年12月开始，Ex Libris更新了出厂FTP服务器；

• FTP服务器处理Alma和外部系统间的文件传输；

• 每个客户享有独占的生产和沙盒两个目录；

• 这两个目录实际在一个总目录下，共享一个密钥

• 您和Alma都有这些目录的读取/写入权限

• 目录最大容量1GB – 超出会出现错误提示

• 数据保留期限30天 – 逾期数据将会被自动删除

• 可选对传输的文件做 PGP 公钥加密

• 参考：配置Ex Libris Secure FTP服务

• 参考：Introducing Ex Libris Secure FTP Service

https://knowledge.exlibrisgroup.com/Alma/Product_Documentation/Alma_Online_Help______(Alma%E4%B8%AD%E6%96%87%E5%9C%A8%E7%BA%BF%E6%89%8B%E5%86%8C)/Alma/Product_Documentation/Alma_Online_Help______(Alma%E4%B8%AD%E6%96%87%E5%9C%A8%E7%BA%BF%E6%89%8B%E5%86%8C)/050%E9%80%9A%E7%94%A8%E7%AE%A1%E7%90%86/050Alma%E9%80%9A%E7%94%A8%E5%8A%9F%E8%83%BD%E9%85%8D%E7%BD%AE/040%E5%A4%96%E9%83%A8%E7%B3%BB%E7%BB%9F/%E9%85%8D%E7%BD%AEEx_Libris_Secure_FTP%E6%9C%8D%E5%8A%A1
https://developers.exlibrisgroup.com/blog/introducing-ex-libris-secure-ftp-service/
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配置步骤 - 1

3

• 配置菜单 > 通用 > 外部系统 > S/FTP定义

• 以上测试环境为例，可以获得如下信息：

• 服务器 custdata-dc81.hosted.exlibrisgroup.com:10022

• 用户 alma_trial_3_inst@customers.ch

• 子目录 production

• 可选参数（需要提前配置“通用 > 管理加密密钥”）

mailto:alma_trial_3_inst@customers.ch
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配置步骤 - 2

4

• 配置菜单 > 通用 > 外部系统 > S/FTP定义

• 点击“生成个人密钥”得到“id_rsa”密钥文件；

• SFTP登录认证使用如上密钥，不需要用户名和密码；

• 点击“生成个人密钥”会重置连接，以前的密钥自动失效；

• 以上配置完整有效，不需要联系ExLibris技术支持即可使用；
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测试准备

5

• Unix Shell

• Windows下可以使用 Git Bash (https://git-scm.com/downloads)

• sftp -o Port=10022 \

• -o IdentityFile=./alma_trial_3_inst \

• -o User=alma_trial_3_inst@customers.ch \

• custdata-dc81.hosted.exlibrisgroup.com

• 应用程序

• 转换密钥 Putty Gen (https://www.puttygen.com/download-putty)

• 连接服务 WinSCP (https://winscp.net/eng/download.php)

https://git-scm.com/downloads
https://www.puttygen.com/download-putty
https://winscp.net/eng/download.php


© 2019 Ex Libris | Confidential & Proprietary

测试连接 - 1

6

• 使用命令行（Unix Shell）

• 使用WinSCP（用Putty Gen转换密钥为PPK格式）

可使用 ls 和 pwd 命令验证
登录成功
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测试连接 - 2

7

• Admin > Run a Job > Export Bibliographic Records

• 在 WinSCP中查看导出结果：
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如果您有兴趣了解 SFTP 命令行

8

• 连接到 SFTP 服务器

• sftp -oPort=2345 user@IP_Address

• 通用导航和目录命令（远程 / 本地）

• 列印 ls / lls，当前目录 pwd / lpwd，导航 cd <dir> / lcd <dir>

• 创建或删除目录 mkdir / lmkdir，rmdir / lrmdir

• 上传本地文件或本地目录

• 文件 put <file> / mput <file1> <file2> <file3>

• 目录 mkdir <dir> + put –r <dir> （需先建立远程同名目录）

• 下载文件或目录到本地（当前目录）

• 文件或目录 get <file> 或 get –r <dir>

• SFTP Command Line Examples (rosehosting.com)

https://www.rosehosting.com/blog/7-useful-sftp-command-line-examples/
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THANK YOU
ChinaSupport@exlibrisgroup.com



© 2017 Ex Libris | Confidential & Proprietary

Analytics Report
Advanced Filter with Variables
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What We Want

• Combine the following three tables into one
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What We Hope

• The result of cross filtering is not desirable
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What We Should

• It seems like using OR operator works

• What if we want to modify the filter conditions (dates)…

• What if there are more filters with the same conditions…
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Some detail about the issued SQL

• Advanced > SQL Issued

• Now we hope for one place to adjust the filters for all…
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Prompt based dynamic filter

However, the prompt data 

type does not have “Date”

We can add variables 

via prompt for filters 

to use globally
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Add Calendar Data Type

• Use the settings in RED > OK > Edit this prompt again

• Observe the magic happened in GREEN…
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• You can set the variable as mandatary with default values

Required and Default
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• Convert filter into SQL and apply the variable

Use Variables in Filters

Replace the filter value with:
@{from}{date '2020-01-01'} AND 
@{to}{date '2020-12-31’}

Notice, the {date '2020-01-01’} 
will be the default value

Apply the same change to the 
other two filters as well
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• The result of the report design:

• Preview the report of its result:

Use Variables in Filters
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Another approach to the resolution

• It IS possible to add filters to columns specifically

• Column Menu > Edit Formula > Filter…

Single quotation mark MUST be used for filter values
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• After creating column filer with static date values

• Presentation Variable (put placeholder in default)

• The final formula with filter and variable applied

• Now you know the tricks of @{var} and {default}

Use Variables in Column Filters
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• Column based filters are all hidden:

• You get almost the same result as before:

Use Variables in Column Filters
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Use Variables in Column Filters

• If you are curious about the issued SQL > Advanced

• Notice the inline filter applied in the SELECT clause

• It is different from the usage of OR in WHERE clause
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Look Out the Limitation

• Each time you go back to the Prompt, you lost the magic

* Notice the prompt falls 

back to Text Field again.

* Do not save or you 

must go through the 

workaround for adding 

the Calendar picker back
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Question time…

• If you do not have question, I have one. The Q1:

The standalone report

The report with OR operator

The report with filter on columns
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The investigation to Q1

• Find the detail of the renewal records

• Lookup the fulfillment history of 2713514979
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The investigation to Q1

• Fulfillment activities of the patron (ID loantest)

• Loan History

There should be 7 renewals
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The investigation to Q1

• Fulfillment activities of the patron (ID loantest)

• The one record above should not have 1 in Renewals

• Notice, its Renewal Date is not in the filter ’s range

• However, its Recall Date is in the filter ’s range

• The OR operator resolution does not work!



© 2017 Ex Libris | Confidential & Proprietary

THANK YOU
ChinaSupport@exlibrisgroup.com
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Analytics Report
Aggregate by Specified Field
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Scenario

• The default Fund Expenditure cannot fulfill requirement

• For the following reasons:

• There are two copies ordered in PO Line o1934703

• The customer paid 609 for each copy of each library

• Furthermore:

• Some PO Line may have different # of copies for each library

• The payment was all placed by the # of copies

• There should be a total statistic and subtotal per library
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Investigation

• How is Fund Expenditure (365.4 & 852.6) calculated:

• Notice the Number of Items value (84 & 36)

• (365.4 + 852.6) *  (36 / (84 + 36)) = 1218 * 0.3 = 365.4

• (365.4 + 852.6) *  (84 / (84 + 36)) = 1218 * 0.3 = 852.6

• The # of copies info is saved in the Receiving Note

• We need to put the # of copies info into metadata for reporting

• Divide Fund Exp. by # of copies per PO line between libraries
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Resolution – # of Copies

• Use 852$t (Copy ID) field for saving # of copies:

• Cast Copy ID data type from String to Integer

• CAST("Holding Details"."Copy Id" AS int)

• Percentage: # of copies / Quantity for Pricing

• Turn on aggregation per column in the Layout settings
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Resolution – Aggregate by POL

• Sum Fund Expenditure per PO Line across Libraries

• Start from the calculation of total Fund Expenditure

* This is the essence of the whole document:

REPORT_SUM("Physical Items"."Fund Measures"."Fund Expenditure" BY "PO Line"."PO Line Reference")



© 2019 Ex Libris | Confidential & Proprietary

Resolution – Aggregate by POL

• How is Fund Expenditure (365.4 & 852.6) calculated:

• Multiply Percentage with Fund Exp. By POL
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Curiosity – POL o1945312

• How is Fund Expenditure (906.13 & 1729.88) calculated:

• Removing the library filter resolves the issue:

It brings in new issues on some other standalone PO Lines
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• Discrepancy: Ordered Items <> Quantity for pricing

• Sum Copy ID directly for calculating the percentage:

• CAST("Holding Details"."Copy Id" AS int) / REPORT_SUM(CAST("Holding 

Details"."Copy Id" AS int) BY "PO Line"."PO Line Reference") * 100

Curiosity – POL o1740131

Items in this PO Line are not fully received
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• Total & Subtotal

• Data Format

The Result
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Notes

• Customized Column Formulas (Check the Advanced tab)

• Fund Expenditure by POL:
• REPORT_SUM("Physical Items"."Fund Measures"."Fund Expenditure" BY "PO Line"."PO Line Reference")

• Fund Expenditure by Copies:
• REPORT_SUM("Physical Items"."Fund Measures"."Fund Expenditure" BY "PO Line"."PO Line Reference") * 

(CAST("Holding Details"."Copy Id" AS int))  / (REPORT_SUM(CAST("Holding Details"."Copy Id" AS int) BY 

"PO Line"."PO Line Reference"))

• Number of Copies:
• CAST("Holding Details"."Copy Id" AS int)

• Percentage: 
• CAST("Holding Details"."Copy Id" AS int)  / REPORT_SUM(CAST("Holding Details"."Copy Id" AS int) BY 

"PO Line"."PO Line Reference") * 100

• This document created from SF case 00913226
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Error

• In case you mee the following error:

• Change the column aggregation rule to: None
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THANK YOU
ChinaSupport@exlibrisgroup.com
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All About Letters Configuration
HTML, XSL, and CSS
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Basic Scenario – Letters Configuration

• Letters: Use XSLT to compose HTML from XML

• Source: XML

• Processer: XSL

• Result: TXT (HTML, XML…)

Navigate in XML tree

Retrieve XML tag value



© 2019 Ex Libris | Confidential & Proprietary

Tool for Testing XSL

• XSLT Validator & Tester - Online Toolz (online-toolz.com)

• Letters - Ex Libris Knowledge Center (exlibrisgroup.com)

• Tips for using XSLT for Letter Configuration

• Next slides summarize the presentations and documents

https://www.online-toolz.com/tools/xslt-validator-tester-online.php
https://knowledge.exlibrisgroup.com/Alma/Best_Practices_and_How-Tos/Letters
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Hide empty fields - IF

• IF the description is empty, do not show it in output. 
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• *** Main Library ***  ->  *** North Library ***

Replace String – WHEN CONTAINS, OTHERWISE

This is part of the XSLT script that convert the Library Name field

Replace
if the lib name 
contains Main

Use Default
if the lib name 
contains no Main

Replace by selective composing
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• Replace all specific string within one XML tag

• Main Library (Main Campus) -> North Library (North Campus)

Recursive Replace – TEMPLATE, PARAM

Call the template 
and pass in the 
parameters

Find the match, replace once
Then recursively call the template
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• Terminate the XSLT transform process or cancel the letter

Throw Error – MESSAGE, TERMINATE

We can:
Censor something
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Date & Time – TRANSLATE, CONCAT, SUBSTRING 

• Take the advantage of XSLT extensions from exslt.org:

Import the date module

Manipulate the system date

Manipulate the due date

For more information about date and other EXLT extensions, refer to http://exslt.org/

http://exslt.org/
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Barcode – This deserves a specific document

• For showing scannable barcode instead of numbers

• Install barcode font to the computer that will show it.

• Free Barcode Font - Code 39 TrueType

• Check the font in Word

https://www.barcodesinc.com/free-barcode-font/
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Barcode – Continues

• Wrap the barcode field with a font specified span tag

• You cannot test the barcode with system letter in Alma

• Since the web server that carries Alma does not have the font

• Send the letter via email to the computer that has the font

• Caution:

• The font is defined in the HTML code of the received letter

• Numeric barcode will show if the recipient does not have font

• You can specify and install any other barcode font
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Basic of the Basics – all about inline HTML style

• You can use tags <> to customize text format or layout.

• Most HTML tags appear in pairs with opening and closing.

• For example:

• <b> tag can make text bold like this: BOLD

• <i> tag can make text make text italic like: ITALIC

• <center> put the enclosed text horizontally centered

• <br/> tag creates more space between lines

• <a href=“URL”> tag can create URL links or email links

• <font color=“X”> use a different font color for wrapped text 

• <font size=“X”> use a different font size for wrapped text

• More options per your exploration online…
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Bonus – Use CSS to create responsive data table

• Some letters on mobile screen deserve an adaptive layout

• The letter shows as a table when the device width is wide

• The letter changes into a list when the device width is limited

• Only requires minor modification to the letter template
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Bonus – Define the CSS in the style.xsl

• General > Letters > Components Configuration > style.xsl

• Create a new template with name “responsiveStyle”

• Take the advice and source code from This Blog

Depending on the ID of the table:
Add CN and EN labels to the list respectively

https://css-tricks.com/responsive-data-tables/
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Bonus – Apply the style and ID the tables

• The minor modifications to the letter template

• Applying the newly created “responsiveStyle”

• Adding IDs to the CN and EN tables respectively

• Test with real mail and device, for compatibility issues…
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Bonus – Apply the style and ID the tables

• The workaround or fallback: static list styled table

• Applying the newly created “responsiveStyle”

• Adding IDs to the CN and EN tables respectively

• Test with real mail and device, for compatibility issues…
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Tips and Tricks – all about making things better

• Check the source XML to see what materials you can use

• Think about what to compose or what condition to make

• Import bib metadata or user info to enrich the XML.

• Check more inspiring XSLT extensions at http://exslt.org/. 

• The Last Candy: Skip duplicated XML element or branch

Use tag_name[X] to specify the Xth

branch or element in the XML

/identifiers/code_value[2]/value

http://exslt.org/
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THANK YOU
ChinaSupport@exlibrisgroup.com
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All About OAS and DV

Ex Libris China Support Team
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Introduction

Topics

• OAS: Oracle Analytics Server

• DV: Data Visualization

Availability

• Since Jan 2021, Alma users in CN have OAS and DV

• Relies on Analytics, DV is only available in Production ENV

Reference

• OAS (Oracle Analytics Server) and Data Visualization (DV)

https://knowledge.exlibrisgroup.com/Alma/Training/Extended_Training/Presentations_and_Documents_-_OAS_(Oracle_Analytics_Server)_and_Data_Visualization_(DV)


© 2020 Ex Libris | Confidential & Proprietary 3

Basic - Analytics and Data Visualization are One

It is the same Catalog in Data Visualization and Analytics
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• Date Type: drag and drop to filter bar > options to set filter

• You can choose to adjust by

• Year, Month, Today, or manual input

4

Basic – Filters by Date, Range, List, and Expression
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• Num Type: drag and drop to filter bar > options to set filter

• Manually input the filter value or use Max or Min

• You can drag the sliders (range indicators) when they are available

5

Basic – Filters by Date, Range, List, and Expression
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• List Type: drag and drop to filter bar > options to set filter

• Choose optional values in left, chosen one appears on the right

• Conditional search the optional filter fields

• Filter could be set to be a reverse filter (exclude values)

6

Basic – Filters by Date, Range, List, and Expression
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• Expression: Filters > Add Expression Filter…

• Result：

7

Basic – Filters by Date, Range, List, and Expression
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Use Case 1 - Replace specific characters in a text field

• Analytics > Data Visualization > Create > Project

• Add Data Set > Subject Areas > Fulfillment > Add to Project

• Search > Policy Name > Add Filter

• Notice mix usage of Month and month

• Add Calculation > Policy Name Rev

• Drag in Policy Name from the left

• Search function with “replace”

• Rewrite the function script to:

• REPLACE(Policy Name, 'week', 'Week')
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Use Case 1 – Replace specific characters in a text field

• My Calculation > Drag in Policy Name Rev > Check the result

• Use REPLACE recursively for replacing other characters:

• REPLACE(REPLACE(Policy Name, 'week', 'Week'),'hour','Hour’)

• There is no technical limit on the recursive usage of REPLACE

• Reference

• How to use functions on fields in Alma Analytics Data Visualization

https://developers.exlibrisgroup.com/blog/how-to-use-functions-on-fields-in-alma-analytics-data-visualization-dv/
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Use Case 2 - most used platforms for previous year

• Usage Data > Usage Data Filter > Add Filters > Previous Year

• Select the following fields and add them to view:

• Usage Date > Usage Date Year

• Platform > Platform

• Usage Data Details – Release 5 > Usage Measures Total
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Use Case 2 - most used platforms for previous year

• After confirm the result > Remove Usage Date Year field

• Drag Usage Measures Total from left column to top filter bar

• After adding the filter > Choose to filter out the top 10

• Do NOT drag the field in the view, if you did carefully put it back

Drag this field 
may make it lost
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Use Case 2 - most used platforms for previous year

• Duplicate Visualization > Change Visualization Type (bar) 
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Use Case 2 - most used platforms for previous year

• Sort the table and the graph

• Share the result in the format of PPTX, PDF, PNG, or CSV:
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Use Case 3 - the most and the least of Usage Total

• Create Project > Add Data Set > Subject Area > E-Inventory 

• Add Fiscal Period Filter to filter bar > Choose Previous Fiscal Year

• Drag Fiscal Period Start End to view > For checking the filter

• Add Usage – Total and Platform (from COUNTER…) to view

Remove this field after checking the result



© 2020 Ex Libris | Confidential & Proprietary 15

Use Case 3 - the most and the least of Usage Total

• Use introduced method to filter out the top 5 and sort them

Let System decide 
which fits the 
data the best
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Use Case 3 - the most and the least of Usage Total

• Menu > Edit > Duplicate Visualization 

Define view-
specific filter
top/bottom N

filter effects all views

Toggle here 
to have more 
space for the 
visualizations

Right click in 
the view to 
sort the results

Customize 
the title as 
you wish

TOPN(field, M) <= N
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Use Case 4 - import external data for Analytics and DV

• Bring in translation to Analytics or DV from external data

Analytics

Data Visualization

External Data
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Use Case 4 - import external data for Analytics and DV

1. Create a new data set by uploading external data in DV

2. Create a project with the data sets that need linking fields

• You can create project from the new data set directly

• Then add other subject area to the project

3. Go to Prepare > Data Diagrams > Add Match (Linking)

4. Add the linked data and the data in concern into view

• In DEMO, they are the CN library name and the number of loans

5. Add filters and apply sorting to the table if it is necessary

6. Duplicate the view and visualize the table side by side
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Thank you!


